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Living in the information age, we benefit tremendously from the abundance and the accessibility of 
information. Global communication, modern medicine, and computers are just few of the endless 
examples of information age products and services that significantly improve the quality of our lives.
 
Because information is valuable, the way you work is largely dictated by its constantly changing and 
abundant nature. Your ability to absorb, assimilate, and communicate information hence dictates the 
success of your work. Whether you are in school or you are a working professional, you must deal 
with a large amount of vital information in a timely and effective manner.

Did you know that exams, job training, business procedures, and sales presentations all share 
common traits? They do: the more you know, the better off you are. And the more you can remember
and integrate the information vital to your work, the better you become at solving problems. The 
purpose of DigiCard, then, is to help you excel and put you ahead.

Simply think of DigiCard as a free-form flash card program, designed with power in mind. DigiCard 
lets you create flash cards and assimilate and memorize your customized information in a variety of 
effective ways. And DigiCard lets you accomplish this via a smooth, friendly interface. This means 
that you can transform a large amount of information into your personal knowledge base faster and 
better than ever before.

Whether you are memorizing a vocabulary list or mastering the national medical board, DigiCard 
makes learning a much less painful and even a fun and rewarding experience!



Students
If you are a student, DigiCard will become your best friend.
n DigiCard will help you decrease your study time, increase retention and boost your grades. One 

DigiCard user is able to consistently achieve high scores on her major college exams. This is 
quite a significant impovement considering she used to be a B student!

n Use DigiCard to memorize key facts and salient points for smooth and successful speeches and 
presentations.

Professionals
Here are examples of how DigiCard can benefit you professionally:
n Preparation for state and national board exams for brokers, insurance agents, engineers, 

doctors, lawyers, CPAs, and other professionals.
n Memorization of procedures and protocols.
n Knowledge of product information and facts.
n Improvement in speeches and presentations.
n Facilitation of on-the-job training.

Uses of DigiCard are only limited to your imagination!



DigiCard is an effective learning tool to help you save time and improve your everyday academic and
professional life. Here are seven reasons why:

n DigiCard is interactive; you are now participating in the learning process rather than being just a 
passive observer (i.e., reading books and listening to lectures).

n DigiCard presents your learning materials to you in six possible ways. You decide what method is
best for you and your particular subject.

n The key to learning is repetition. DIgiCard greatly facilitates and accelerates this process for you.
n The prerequisite to understanding is memorization. DigiCard not only helps you memorize your 

material, it encourages your mind to integrate the information. This occurs because the human 
mind has a great tendency to create a conceptual framework around related ideas.

n Even the act of making flash cards reinforce learning. The mental task of deciding whether to 
include or exclude information from a card and the act of typing serve as two different modalities 
to    complement your learning.

n DigiCard lets you use time efficiently; all of your learning and reviewing time can be used to 
master cards containing difficult or unfamiliar concepts when you discard those that you know 
well.

n DigiCard stimulates your recall time and efficiency with the automatic presentation feature (Card 
Shooter). You can now play games using your learning material as you try to beat the clock to 
the answers!



 See Also

While DigiCard is easy to use, the following sections are designed to make sure you get the most out
of DigiCard. We will begin with an overview that will get you acquainted with the basic components of
the program. Then, we will go through a simple exercise and make your first DigiCard file. The 
sample file "States and Capitals" is provided to demonstrate the various ways you can review your 
learning materials.

DigiCard consists of two modules, the Editor and Viewer. The Editor allows you to make up your 
flash cards. That is, it lets you enter the questions, answers, and keywords. You can edit and revise 
any information in your DigiCard file at any time using the Editor.

The Viewer presents to you the cards you have made using the Editor. The Viewer is flexible; you 
can instruct the Viewer to present your cards in ways that match your study style, the subject matter, 
or even your mood. For instance, the Viewer can show you your cards by three styles of presentation
(Sequential, Random, and KeyLink). Or you might decide to reverse the order of the usual question-
then-answer format to that of an answer-then-question format (a-la-Jeopardy). Together, you have 
six different presentation schemes, which are designed to significantly improve the way you 
memorize and integrate information. Time is spent efficiently while reviewing, because when you 
discard those cards that you know well, you are studying only unfamiliar concepts and saving 
valuable time. Since the whole process is interactive, studying no longer has to be boring!

In the next two sections are two tutorials to get you aquainted with Editor and Viewer functions. 
When you strike out on your own, remember that help is with you every step of the way. If there is an
object on the screen you have questions about, just point to it and look a the status box located at 
the right hand side of the tool bar for a brief description. If you are still stuck, just hit the F1 key.

Tutorial 1: A Simple Exercise
Tutorial 2: Sample File "States and Capitals"



See Also...
Presentation Style
Presentation Format



Presentation Style
Sequential
Random
KeyLink



Sequential Style of Presentation
n Cards are presented sequentially, from the first card to the last.
n This is the default presentation style.
n Tip: Use this style of presentation for initially reviewing your cards or for subject matters that are 

sequential in nature (i.e., preparing for oral presentations).



Random Style of Presentation
n Cards are presented to you randomly from a constantly shuffled deck.
n Tip: Randomly presented cards, over time, fosters associative learning. The random nature will 

provide new points-of-view and allow your mind to integrate related information much more 
quickly than the traditional method of study.



KeyLink Style of Presentation
n Although keywords are optional, some of your cards must contain one or more keywords in order

to take advantage of KeyLink presentation.
n In KeyLink, DigiCard surveys all of your cards and group your cards together according to 

keywords. DigiCard then randomly selects a group at a time for presentation. See tutorial 2 in 
this help file for a demonstration of the KeyLink feature.

n The frequency at which a group is selected for KeyLink presentation is proportional to the 
number of cards the group contains. Thus, you will see cards from a large group more often than
small groups.

n Tip: KeyLink is ideal for reviewing related concepts in groups. Viewing related cards in groups 
stimulates the formation of a mental framework and ensures that you are seeing every card in 
the proper context.



Presentation Format
Question First
Answer First



Question First Format
n The question comes before the answer.
n This is the default presentation format.



Answer First Format
n Exact reverse of the question first format - answer comes first, then question. Just like Jeopardy.
n Tip: Ideal for definitions and other short answers. The reversal is especially beneficial for 

reinforcing your knowledge of the subject matter at hand.



To make it easier to follow, select 'Print Topic' from the File menu for a printout.
This section will help you get started making your first DigiCard file and to acquaint you with the 

Viewer. Simply follow the steps below:

1 Using your learning material, let us begin by making a file of several cards. From the File menu, 
select 'New.' In the Editor, click once on the window labeled 'Question.' You will now see the 
blinking cursor in the question window. Now type in your first question.

2 After you enter the question, you can either hit the tab key or click once on the window labeled 
'Answer.' The blinking cursor is now in the answer window. Now answer the question you have 
posed. Take care to phrase your answer as concisely as possible, as this will increase the 
efficiency of learning and increase retention.

3 Now you are ready to save the card. Using the mouse pointer, click on the 'Save' button. When 
the contents of the card is saved to disk, the button will change to 'New Card.' Click on this 
button.

4  At this time, note that the toolbar will inform you that you are on "Card 2 of 2." Repeat steps 1 
through 4 several more times. Save the file by selecting 'Save As' under the File menu and 
provide a name for your DigiCard file.

5 When you have about five cards, we are ready for a demonstration of Viewer features. Switch to 
the Viewer module by clicking on the snow flake icon (between the delete and left arrow buttons).

6 In the Viewer, you will notice right below the tool bar the word "Sequential." This indicates that 
the sequential presentation style is currently active. Use sequential presentation for reviewing 
your newly created cards, making sure the questions and answers are the way you like them to 
be.

7 Begin your review. To see the answer, push the 'Show Answer' button. You will notice that the 
label changes to 'Next'. Push this button when you are ready to move on.

8 Repeat this process for all of your cards. At any time if you want to edit your card contents, 
double click on the Viewer window.

9 Now we will try out the random style of presentation. Push the 'Options' button and select 
'Random'. Press OK.

10 Notice that card presentation is totally randomized now. Randomly presented cards, over time, 
fosters associative learning. Whenever you encounter a question, try hard to state the answer 
before you go on to the next card.

11 As you go through your cards a few cycles, you will notice that information will begin to stick. 
Before you disable a card containing information that you think you know well, make sure you 
see the card several more times to solidly reinforce the learning. To disable a card, click the 
'Discard' button.

12 When all cards are disabled, you will be notified of this and DigiCard will automatically enable all 
cards. Before we end this tutorial, try the reverse question-answer format. Push the 'Options' 
button and select 'Answer First.' Now studying can be just as challenging as playing Jeopardy!

Congratulations! You have completed your first DIgiCard tutorial. As you complete your file, note that 
you can specify the start up configuration by setting and saving your preferred options (i.e., Random 
and Answer First). You can even set the start up module for this file to Viewer, so that the next time 
the file is loaded, you will be ready for review (go to the Options menu and set the start up module to 
Viewer).



To make it easier to follow, select 'Print Topic' from the File menu for a printout.
If you are new to DigiCard, be sure to go through tutorial 1 before beginning this one. In this tutorial, 
we are going to explore the KeyLink feature. In KeyLink, DigiCard surveys all of your cards and 
group your cards together according to keywords. KeyLink is ideal for reviewing related concepts in 
groups for maintaining the proper context.
The sample file "States and Capitals" illustrates the use of keywords in KeyLink presentation. Simply 
follow the steps below:

1 In this sample file, states are categorized by time zones. For instance, all of the cards 
representing states in the Eastern standard time zone have the keyword "Eastern" and likewise 
for the other states. From the File menu, open the file 'SAMPLE.CRD' in the directory containing 
the DigiCard program.

2 After the file loads, you will notice that the Viewer module is active for KeyLink presentation. As 
you place the arrow on the 'Show Answer' button, also note that the status window is displaying 
the word "KEY" followed by a time zone. This indicates the active keyword. In this case, 
keywords are time zones of the United States.

3 As you browse through the cards, DigiCard will present every state/capital located in the 
displayed time zone. After the last state/capital of the time zone is presented, DigiCard will 
randomly select another group of states with their capitals by time zone. Try this for yourself.

4 If you prefer, you can keep the active keyword from being displayed by selecting 'Hide Keyword' 
from Viewer options.

5 The way gouping cards together by keywords is accomplished is really very simple. Switch over 
to the Editor and go to card # 1. There are 51 cards total and the states are in alphabetical order.
Navigate through the deck by using the next card button. Notice that with a few exceptions, every
card contains only one keyword. See if you can spot the the states that reside in two time zones.

6 Switch back to the Viewer. Let's turn this exercise into a game. Click once on the Shooter button.
You will notice that each side of every card is now displayed for two seconds. Now you can test 
your knowledge of US States and Capitals against the clock! Press the Shooter button (now 
labeled 'Stop') to end Card Shooter.

As you can see, you can easily add keywords to your cards and take advantage of KeyLink 
presentation. Viewing related cards in groups is advantageous because it stimulates the formation of 
a mental framework and ensures that you are seeing every card in the proper context. The Card 
Shooter feature adds a new level of challenge as it enhances your learning.



The following sections will explain to you the purpose of the various visual elements in DigiCard. 
Choose a section below and click on an object you need help with:

Menu and Tool Bar Interface
Editor Interface
Viewer Interface



Click an object you need help on...



Menu and Tool Bar help

Click an object you need help on...



Menu and Tool Bar help

Click an object you need help on...



Read-Only Access

Sometimes after you compose your deck of cards, you may wish to lock the contents so that 
information could not be accidentally altered. DigiCard provides a way for you to accomplish this. To 
change the read-only attribute for a particular DigiCard file, use a text editor and open the 
corresponding .CFG file. Under the [Attributes] section you will find the line:

ReadOnly=False

Change 'False' to 'True' to enable read-only access for the file. Reload the file for the change to take 
effect. Please note that with the read-only attribute activated you also benefit from faster data 
access.

Network Usage

DigiCard is designed to work well within a network environment. DigiCard can either be installed on a
central file server or on individual workstations.

To share a DigiCard file across a network (multi-user access), its exclusive attribute must be 
changed. To do this, use a text editor and open the corresponding .CFG file. Under the [Attributes] 
section you will find the line:

Exclusive=True

Change 'True' to 'False' to enable multi-user access to the file. Reload the file for the change to take 
effect.

Note: It is highly recommended that the read-only attribute is set to true when multi-user access is in 
effect. This will prevent data from being altered.

Changing Fonts

You can substitute the fonts used in the DigiCard text windows and printouts with those of your own. 
Examples of fonts that can be used under DigiCard include foreign languages, symbols from 
science, math, and engineering, and anything else available as a Windows-supported font.

To change the font, use a text editor and open DIGICARD.INI in your DigiCard directory. Under the 
[Preferences] section you will find the lines:

QuestionFontName=Arial
AnswerFontName=Arial
Key1FontName=Arial
Key2FontName=Arial
TextBoxFontName=Arial

Simply change the default font from Arial to your preferred font for any or all of the Editor text 
windows. You do not need to separately set the Viewer and printer functions, since they will 
automatically adjust to the new fonts set for the question and answer windows.



Running DigiCard off a Floppy

It is possible to run DigiCard off a floppy disk (i.e., on school computers). To do this, you must copy 
DIGICARD.EXE, VBRUN300.DLL, plus all of the .VBX and .DLL files associated with DigiCard onto a
single floppy disk (please see 'Distributed Files' section). However, the performance of the program 
will be very sluggish. This is due to the slow nature of the floppy drive and the frequent system file 
accesses DigiCard need to perform for its basic and database functions.

If possible, perform a complete install of DigiCard. If this cannot be done due to network regulations, 
try to copy the contents of the floppy disk mentioned above to a single directory on a local hard drive 
(i.e., C:\DIGICARD). If all else fails, tell the system administrator at your organization what a great 
program you have and that you would really like to install it and make it available for everybody!



When you register DigiCard, you receive many benefits. These include:

n Removal of the start-up introductory window.
n Ability to print (with preview) any or all cards.
n License to use ALL future releases of DigiCard.
n Copy of fhe latest registered version of DigiCard promptly mailed to your address.
n "Strategies for Success," a companion guide to DigiCard which is loaded with helpful tips to 

boost your academic and professional performance.
n One year free CompuServe / Internet e-mail / BBS / US Mail support.

Registration fee is only US $20 (S&H included!). If you would like the author to contribute 40% of the 
received registration fee to charity, please provide the name of the organization. Thank you!

      Click Here to Register!



You have a choice to either register DigiCard through CompuServe or by US mail. Simply click on a 
choice below:

      Registration via CompuServe

      Registration via US Mail



n To register through CompuServe, GO SWREG and select registration ID # 2211.
n The registration fee of $20 per copy will be billed to your account.
n The latest registered version of DigiCard will be mailed the next business day.
n Please contact the author regarding which charity you'd like to benefit through your registration.

How to Contact the Author



The author is dedicated to the success of DigiCard users. For product support and/or suggestions on
how DigiCard can be improved, you may contact the author, Rob Chen, by any of the following ways:

n CompuServe ID: 73542,1232
n Internet Address: rchen@orion.oac.uci.edu
n BBS: Chips+ Connection (11 nodes)

1-714-556-3207
1-714-556-3208
1-714-760-3265

n US Mail: 6014 Verano Place
Irvine, CA    92715-3159

About the Author



About the Author

Hi, my name is Rob Chen and I am currently attending graduate school at University of California, 
Irvine. I aspire one day to help mentally retarded children by way of medical care and research. I am 
now in my second year of study.

DigiCard is initially the product of interest in helping my classmates and myself fufill a need in having 
an effective learning tool. Because of the success of DigiCard, I was encouraged to enhance and 
release the program to the general public. DigiCard is charityware because I firmly believe that there 
are many worthwhile causes that are in need of support. DigiCard thus fufills both my desire to help 
needy people and environmental concerns and to create a good program that helps people study 
and achieve their goals.

I appreciate any suggestions concerning this program. Please contact me and let me know of your 
experience.



To print the following form, select 'Print Topic' from the File menu.

Mail-In Form

n Please register me for DigiCard and send me the latest version. I am sending a check or money 
order for the amount of US $20 (per copy).

Name:_______________________________________________________

Occupation:__________________________________________________

Company:____________________________________________________

Address:_____________________________________________________

City:________________________________________________________

State:_______________ Zip:______________ Country:_______________

Telephone # _________________    (optional)        Number of Copies: ______

n Send me disk format: _____ 3.5", 720k _____ 5.25", 1.2 meg 
 (check one) _____ 3.5", 1.44meg

n Comments / Suggestions:

____________________________________________________________

____________________________________________________________

____________________________________________________________

Please send completed form and registration fee (payable to 'Rob Chen') to:

ROB CHEN
6014 VERANO PLACE
IRVINE, CA    92715-3159



This section contains most of the errors users encounter while installing and using DigiCard. If you 
need technical assistance, please refer to this section first. If you are still stuck, please do not 
hesitate to contact the author for help : - )

Error During Setup
If an error is encountered during the setup process, the nature of the error will be reported to you by 
Setup. Errors encountered during setup are mostly related to the inability of the setup program to 
overwrite a previous version of one of the system files. You can fix this by renaming the extension of 
the file in question to .BAK (i.e., COMMDLG.DLL to COMMDLG.BAK) and re-installing DigiCard. To 
access the file in question, log onto your \WINDOWS\SYSTEM directory either from DOS or from 
File Manager.

Error At Runtime
In order for DigiCard to execute properly, all of the system files outlined in the 'Distributed Files' 
section (i.e., all .VBX and .DLL files) must be present in order to run. The .VBX files are normally 
installed to your DigiCard directory and the .DLL files to your \WINDOWS\SYSTEM directory. If for 
whatever reason a file is missing or a previous version is not replaced by DigiCard Setup, DigiCard 
will not run. The nature of the error, along with the missing file, will be reported to you. You can fix 
this by renaming the extension of the file in question to .BAK (i.e., COMMDLG.DLL to 
COMMDLG.BAK) and re-installing DigiCard.

If you encounter an abortive error while opening a DigiCard file (i.e., SAMPLE.CRD), make sure file 
sharing is activated on your computer. Using a text editor, check your AUTOEXEC.BAT file for 
SHARE.EXE. If Share is not present, add the following line to AUTOEXEC.BAT (assuming your DOS
directory is in the path):

SHARE.EXE /L:500

And reboot your computer. This should fix the problem. Please note that file sharing is innate to 
Windows for Workgroups and you do not need to load SHARE.EXE.



Evaluation
Thank you for using DigiCard. Please note that you may use DigiCard for a period not to exceed 45 
days for the purpose of evaluation. After this period, the author asks that you either register or 
discontinue the use of DigiCard. Registration of a single copy of DigiCard entitles the registrant the 
right to run it on a single computer.

Although the author makes his every best effort to ensure that DigiCard performs optimally and error-
free prior to releasing the software to the general public, users should read carefully and understand 
the disclaimer below before using DigiCard.

Disclaimer of Warranty
THIS SOFTWARE AND ON-LINE DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    BECAUSE OF THE VARIOUS HARDWARE AND 
SOFTWARE ENVIRONMENTS INTO WHICH THIS PROGRAM MAY BE PUT, NO WARRANTY OF 
FITNESS FOR    A PARTICULAR PURPOSE IS OFFERED.    GOOD DATA PROCESSING 
PROCEDURE DICTATES THAT ANY PROGRAM BE THOROUGHLY TESTED WITH NON-
CRITICAL DATA BEFORE RELYING ON IT.    THE USER MUST ASSUME THE ENTIRE RISK OF 
USING THE PROGRAM.    ANY LIABILITY OF THE AUTHOR WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE. USAGE OF THIS SOFTWARE 
CONSTITUTES AS ACCEPTANCE OF THE TERMS OF WARRANTY.



The following are files packed into the file zip file for distribution. If any of the following files are 
missing or damaged, please contact the author for replacement.

n README.TXT Read this file first.
n FILE_ID.DIZ BBS description.
n VENDOR.TXT For shareware distributors and

Sysops of on-line services.
n DIGICARD.EX_ DigiCard executable program and

DIGICARD.HL_ On-line help file.
n SAMPLE.CR_ Sample file "States and Capitals" and 

SAMPLE.CF_ Sample file configuration.
n SETUP.EXE DigiCard 2.0 setup files.

SETUP.LST Run SETUP.EXE to install DigiCard.
SETUP1.EX_
SETUPKIT.DL_

n CMDIALOG.VB_ DigiCard system files.
INICON3.VB_ All files must be present for DigiCard to run.
SPIN.VB_
THREED.VB_
COMMDLG.DL_
DDEML.DL_
MSAES110.DL_
MSAJT110.DL_
VBDB300.DL_
VBPRINT.DL_
VER.DL_



The minimum system configuration required to run DigiCard 2.0 is:

n 4 megs RAM.
n 2 megs disk space.
n VGA graphics.
n Microsoft Windows 3.x.
n A copy of VBRUN300.DLL in your \WINDOWS\SYSTEM directory.



VERSION 2.1 (5-1-94)

New Features:
n Undo typing feature to ease card composition and editing.
n Arrange icons function for asthetics.
n Card Shooter -- "hands free" presentation tool -- automatic timed presentation.
n File menu open items. The four most-recently opened files are represented sequentially under 

the file menu to speed up file opening.
n Editor Scripts available now as menu choices.
n Fonts - now you can use your favorite Windows fonts under DigiCard. Please see 'Tips and 

Tricks' section for instructions on how to change fonts.
n Read-only access. Please see 'Tips and Tricks' section for instructions on how to make files 

read-only.
n Network support. Please see 'Tips and Tricks' section for instructions on how to set up DigiCard 

for multi-user access.
n Print (registered version). Supports printing of any or all cards on Avery form 5388 or on any 8.5" 

x 11" paper. Preview allows you to format and edit cards to your liking before printing.

Bug Fixes:
n Viewer windows now support up to 32k bytes of text, rather than 1k. (Oops!)
n GPF when opening large files now fixed.
n 'Object variable not set' error followed by termination of DigiCard when opening is now 

eliminated. This error occurred on some users' machines because SHARE.EXE was not loaded.
n SHARE.EXE is no longer needed, unless 'Exclusive' (in the appropriate .CFG file) is set to false 

(i.e., networked access).

Changes
n To access the 'Go To...' feature, click once on the card number indicator on the toolbar (i.e., 'Card

1 of 51'). The 'Go To...' button is replaced by the 'Scripts' button on the Editor and 'Shooter' 
button on the Viewer.

n DIGICARD.INI is now located in the DigiCard program directory (you may now delete the 
DIGICARD.INI file located in the \WINDOWS directory).

n All files ending with .VBX are now installed to the DigiCard program directory. This is done 
because some users reported problems with the Setup program not being able to overwrite older
versions of these files.

VERSION 2.0a (4-10-94)

Bug Fixes:
n [Escape] key now exits forms.



n Discard record now written to the appropriate .CFG file only. Previously it was written 
unnecessarily to both the .CFG file and DIGICARD.INI.

n Changes do not take effect now when cancel is selected from Viewer Options menu.
n When switching from KeyLink to other presentation styles while enabling all cards, not all cards 

were enabled. This is now fixed.
n Better error trapping when attempting to open non-DigiCard files.

VERSION 2.0 (3-15-94)

New Features:
n Implemented Microsoft Access 1.1 engine for data storage and handling. All DigiCard files are 

convertable to other database file types supported by Access (i.e., dBase, Fox Pro, etc.).
n Added two keyword fields per card.
n Added function for rapid search based on keywords.
n Enhanced the presentation module by adding KeyLink presentation.
n Simplified learning for novice users by adding context-sensitive help. This was done both in the 

form of status-line description of buttons and Windows help file when activated using the F1 key.
n Added the ability for the user to specify the default module upon start-up.
n Implemented a configuration file containing discard information and Viewer options unique to 

each DigiCard file.



Answer Window
n Contains an answer or response to the posed question.
n Text can be up to 32,000 characters in length.
n To insert a Tab:    [CTRL][ALT] & [TAB]
n Tip: make the answer as direct and concise as possible, as this will enhance learning and 

retention.



Auto-Discard
n Click once to check, again to uncheck.
n Auto-discard allows you to see each card once per round of presentation when you are using 

Random or KeyLink.
n All cards are automatically enabled when all cards have been discarded, at which time the cycle 

can start again.
n Tip: This is especially useful for the beginning of a study session or before an exam, when you 

may want to see every card several times in a short time frame.



Cancel
Disregard all changes and exit.



Card Number Indicator
n This displays the current card number and the total number of cards in your DigiCard file.
n Click once to go to another card.



Clear All Scripts
Checking this box will clear all five Editor scripts.



Control Box
To exit DigiCard, click on this twice.



If you have already invested time and energy into building flash cards for another program, 
converting the files to DigiCard format may be a relatively painless process. If your flash cards 
are saved to ASCII text files, just follow the simple steps outlined below:

1 From the File menu, select 'Import Text'.
2 Open your flash card file. TextPad will be activated automatically and you will see your file 

contained within.
3 From the Options menu, select 'Drag and Drop Editing' (if it is not already checked).
4 Highlight the question you want to incorporate into DigiCard. Then simply drag the question and 

drop it into the question window.
5 The process for the answer is the same. When you are done with the card, press the 'Save' and 

then the 'New Card' buttons.
6 Repeat steps 4 and 5 for other question-answer pairs.

Please contact the author if you would like to see a converter for your popular flash card program 
with the next release of DigiCard.



Copy
n Copies highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other applications.



Cut
n Cuts out highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other applications.



Delete
n Deletes current card from file.
n WARNING: Once your card is deleted from the file, it cannot be recovered. Take care in 

confirming deletes.



Discard
n Disables the current card.
n Clicking on this button temporarily inactivates the current card and keeps it from being displayed 

in Viewer presentations (note: this is not the same as delete).
n You can enable inactivated cards by either toggling the light bulb on (the card in question must 

be current) or by selecting the "Enable all cards" check box under Viewer Options.
n Tip: Your study time can be used most efficiently when you discard those that you have already 

mastered. This allows you to use all of your time learning new information.



Edit Menu

Cut, copy, and paste functions in DigiCard just like in other Windows applications. For instance, you 
may paste information from a word processor document into the DigiCard Editor and vice versa.

Undo Typing
n Undo text modifications since the last [backspace] key.
n Select again to undo the first undo operation.
n Shortcut:    [CTRL] [Z]

Cut
n Cuts out highlighted Editor text to the Windows clipboard.
n Shortcut:    [CTRL] [X] or [SHIFT] [DELETE]

Copy
n Copies highlighted Editor text to the Windows clipboard.
n Shortcut:    [CTRL] [C]

Paste
n Pastes Windows clipboard text to the Editor.
n Shortcut:    [CTRL] [V] or [SHIFT] [INSERT]
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Enable All Cards
n Check this box off when you want to enable all of your cards for Viewer presentation.
n This option is available when one or more cards are inactivated.
n Tip: You may enable or disable individual cards by turning the light bulb on or off, respectively. 

The light bulb is located on the toolbar, and the easiest way to do this is to to navigate through 
your deck of cards using the the Editor.



File Menu

DigiCard file structure is based on the Microsoft Access 1.1 database engine. Using Access, 
DigiCard data can be manipulated and translated to many other database formats (i.e., dBase III, IV).

New
n Exit current file and create an untitled new file.

Open
n Open file. By default, DigiCard files have the .CRD extension.

Save As...
n Save your current DigiCard file under a new filename.

Import Text
n Open a text file into TextPad.
n Text file must be under 32k and devoid of hard page breaks.

Print (Registered Version)
n Prints three 3" x 5" cards onto Avery form 5388 (or an 8.5" x 11" sheet of paper).
n Prints all cards, current card, or a range of cards.
n Preview allows you to format and edit text before printing.

Exit
n Exit DigiCard.

File Items (1-4)
n Recently opened files, 1 = most recent.
n Selection opens the file.



File Name
Indicates the name of the current DigiCard file.



Fixed Interval
n Select this option if you want a single shooter interval (the time between turnover).
n Fixed interval is defined in terms of seconds. Default is 5 seconds.
n This is the default Card Shooter mode.



Go To...
n Navigates the database of cards contained in the opened DigiCard file.
n Type in number directly or use the spin control to select a card.



Help Menu

You are currently in DigiCard help.
Press F1 for help on Windows Help.



Hide Keyword
n Click once to check, again to uncheck.
n By default, the active keyword is automatically displayed in the status window during KeyLink 

presentation.
n Hide keyword will prevent the active keyword from being displayed.
n This option is available when using KeyLink.



Keyword
n Keywords are necessary if you want to take advantage of KeyLink style of presentation. You can 

also search through the file for particular cards by using the search function in the Editor.
n You may enter one or two keywords per card.
n Tip: A keyword should be a word that captures the essence of the card containing it.



Discard Status
n Light on: current card is active for Viewer presentation.
n Light off: current card is inactive.
n You can toggle the discard status of the current card by turning the light bulb on or off.



Maximize
Expands the main DigiCard form to fill the screen.



Minimize
Reduces the active module to an icon.



New DigiCard File
Exits current DigiCard file and creates an untitled new file.



Next Card
n Sequentially forward navigates the deck of cards.
n Any changes made to the current card are saved automatically.



OK
Executes all changes and exit.



Open DigiCard File
By default, DigiCard files have the .CRD extension.



Options Menu

Viewer Options
Presentation Style
Presentation Format
Auto-Discard
Hide Keyword

System Options
            Startup Module
n Selection of either Editor or Viewer will enable that module to start-up automatically when 

opening a DigiCard file.
n This information is saved to the configuration file.

            Drag and Drop Editing
n Checking this option will allow drag and drop copying of highlighted text from one Editor window 

and pasting it to another.
n Recommended for copying imported text to the Editor.

            Monochrome Display
n Check this option if you have a monochrome display.

Save Options
Saves all options. Viewer options are saved to .CFG file and DigiCard system options are saved to 
DIGICARD.INI.



Paste
n Pastes Windows clipboard text to the Editor.
n Clipboard contents may be from DigiCard or other applications.



Percent Enabled
n Displays the percentage of cards that are currently active for Viewer presentation.
n Ranges from 100% (all cards enabled) to 0% (all cards disabled).



Previous Card
n Sequentially backward navigate the deck of cards.
n Any changes made to the current card are saved automatically.



The current version of DigiCard supports printing of three 3" x 5" cards per sheet of paper (8.5" x 
11"). The format is compatible with Avery 5388, available at most office supply and computer stores. 
As a good and inexpensive compromise, use heavy bond paper and turn border printing on (in print 
preview) for use as crop marks.

Print Dialog
All
Print all loaded cards.

Selection
Print the current card.

Pages
Print the indicated range of cards (pages = cards).

Print Preview
In print preview, you will see the question side of all the selected cards first, then the answer side. 
You will get a chance to edit each card before printing. For example, you may want to perform editing
on particularly lengthy cards to keep the text within the 3" x 5" area. Or you may want to give a card 
the right look on paper by modifying the text layout. Any changes you make in the preview window 
will be restricted only to printing; the DigiCard database will not be modified in any way.

Print
Accept any changes and print the current side.

Print All
Print all cards without further preview.

Cancel
Abort printing and exit preview.

Print Border
While previewing the questions, you will have the chance to toggle border printing off and on (default 
= on). Leave border printing on if you are printing onto a plain sheet of paper. Turn off border printing 
if you are printing onto Avery 5388 index cards.

Note: Print is a registered feature.  



Question Window
n Contains a question or statement that will be elaborated upon in the Answer Box.
n Text can be up to 32,000 charaters long.
n To insert a Tab:    [CTRL][ALT] & [TAB]
n Tip: make the question as direct and concise as possible. The desired effect is to have your 

question automatically trigger the answer in your mind.



Relative Interval
n Select this option if you want the shooter interval (the time between turnover) to adjust according 

to the text length.
n Relative interval is set by your reading speed (in words per minute). Default is 150 wpm.
n If the relative interval is selected, the fixed interval becomes the minimum amount of time a 

question or answer will display before turning over.



Repeat
Redisplay the question.



Save
n If new editing has occurred, the save button appears.
n Click on the button to save changes and to update the Viewer.

New Card
n Adds a new blank card to the deck.
n The new card will be added to the end of the deck.



Save As...
n Save your current DigiCard file under a new filename.
n By default, DigiCard files have a .CRD extension.



Save Options
n Checking this box off will allow all Viewer options to be saved to disk.
n Viewer options for a particular DigiCard file are unique to that file. The next time you load a 

DigiCard file, all the saved settings will be retained.
n The options configuration file has the same name as the corresponding DigiCard file with a .CFG

extension.



Apply Script
n Scripts can be applied only if you are currently in an Editor window.
n A script can be applied to the active Editor window by either clicking on the appropriate 

numbered button or by hitting [SHIFT] and the corresponding function key (F1-F5).



Script Window
n This time-saving feature is designed to save you from repetitive typing in the Editor.
n A script contains commonly used words, phrases, sententences, etc. that you use to formulate 

your questions, answers, and keywords. For instance, you may preface many questions with the 
phrase "What is the significance of..." Having this phrase as a script allows you to apply it very 
quickly and thus save time.

n To apply a script, first locate your cursor at the insertion point or highlight the text you want to 
replace. Then, select the 'Scripts' item on the menu and push the corresponding button.

n Shortcut: Locate your cursor as above and press [SHIFT] and the function key that corresponds 
to your script (F1 to F5).



Scripts Menu

Edit Scripts
Brings up script editor.

Scripts
n With the menu pulled down, selectable by number.
n Shortcut:    [Shift] [F1-5]



Scroll Bar
Scrolls text upward or downward.



Search
n Finds card(s) based on keyword.
n Editor searches through Key 1 field first, then Key 2.



Shooter Button
n Card Shooter is a "hands-free" presentation tool -- automatic timed presentation.
n Click once to start Card Shooter, again to stop.
n Shooter intervals can be set under Viewer Options.



Show Answer / Next
n If a question is on display in the Viewer window, clicking on this button will reveal the answer.
n If an answer is on display, clicking on this button will advance to the next card. The card you get 

next will depend on the style of presentation (sequential, random, or KeyLink).



Status Window
n When you have questions about screen objects, point to the object and the status window will 

display a short description.
n Under KeyLink presentation, the status window will display the current active keyword.
n Tip: Click to toggle help description on and off.



Switch to Editor Module
Activates the Editor Module.



Switch to Viewer Module
Activates the Viewer Module.



TextPad
n Click to activate TextPad. Click again to deactivate.
n TextPad is automatically activated when a text file is imported into DigiCard.
n Use the TextPad to copy text directly into the Editor when making DigiCard files.
n Tip: Use drag and drop editing to save time. To turn it on, check 'Drag and Drop Editing' on the 

Options menu.
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Viewer Window
n Shows questions in red, answers in blue.
n Double-clicking the Viewer window activates the Editor and allows editing of the current card.



Window Menu

Arrange Icons
Arrange the Editor and Viewer icons to the lower left corner.

Editor
Switch to Editor Module.

Viewer
Switch to Editor Module.






